# TABLE OF CONTENTS

1 **INTRODUCTION**
   1.1 Overview .......................................................................................... 1-1
   1.2 System Requirements ...................................................................... 1-2
   1.3 Installation ........................................................................................ 1-2
      1.3.1 DCOM Configuration (Windows 2000) .................................. 1-5
      1.3.2 DCOM Configuration (Windows XP) ..................................... 1-9
   1.4 Reference to Other Documentation................................................ 1-14
   1.5 Customer Service Information........................................................ 1-14

2 **SAFETY**
   2.1 Introduction....................................................................................... 2-1
   2.2 Standard Conventions...................................................................... 2-2
   2.3 General Safeguarding Tips .............................................................. 2-3
   2.4 Mechanical Safety Devices .............................................................. 2-3
   2.5 Installation Safety ............................................................................. 2-4
   2.6 Programming Safety......................................................................... 2-4
   2.7 Operation Safety .............................................................................. 2-5
   2.8 Maintenance Safety.......................................................................... 2-6

3 **USING THE OPC CONTROL CONSOLE**
   3.1 Overview .......................................................................................... 3-1
   3.2 Starting the Motoman Control Console Application.......................... 3-1
   3.3 Description of OPC Control Console................................................ 3-1
   3.4 Connections ..................................................................................... 3-3
      3.4.1 Add Connection .................................................................... 3-3
      3.4.2 Remove a Connection .......................................................... 3-5
      3.4.3 Edit a Connection .................................................................. 3-5
      3.4.4 Open a Connection ............................................................... 3-5
      3.4.5 Close a Connection ............................................................... 3-5
      3.4.6 Status Details ........................................................................ 3-6
   3.5 Help.................................................................................................. 3-6
      3.5.1 About ..................................................................................... 3-6
   3.6 Exiting the Application ...................................................................... 3-7

4 **USING THE OPC SERVER**
   4.1 Overview .......................................................................................... 4-1
   4.2 Item References ............................................................................... 4-2
      4.2.1 Status Information ................................................................. 4-3
      4.2.2 Job Information ..................................................................... 4-4
      4.2.3 Alarms and Errors ................................................................ 4-5
      4.2.4 Concurrent IO ....................................................................... 4-5
      4.2.5 Variables ............................................................................... 4-6
      4.2.6 Positions ............................................................................... 4-7
      4.2.7 Frames .................................................................................. 4-7
NOTES
SECTION 1
INTRODUCTION

1.1 Overview

The Motoman OPC Server was developed using the OLE for Process Control (or OPC) specification (which includes OPC 2.0). This specification, which was developed by the OPC Foundation, is based upon Microsoft's Object Linking and Embedding (OLE) / Component Object Model (COM) technology. The OPC standard interface makes possible interoperability between automation/control applications, field systems/devices, and business/office applications.

OPC is an industry standard created with a number of leading worldwide automation and hardware/software suppliers and Microsoft. OPC ensures that automation systems can share information and interoperate with other automation and business systems plant or factory wide. The number of members participating in the OPC Foundation is constantly increasing.

The Motoman OPC Server software package consists of three core components:

- OPC Control Console (used for administering device connections)
- OPC Server (an extensible OPC server, capable of simultaneously supporting multiple devices)
- OPC Server extensions (mxme.dll) Encapsulates the communication capabilities of the Motoman XRC/MRC/ERC robot controllers.

Currently, only one OPC extension is supplied: mxme.dll. It provides connectivity to XRC, MRC, and ERC type of controllers. The extension uses the low-level communication services provided by the Motoman Device Server COM server (MDS).

In addition to basic OPC types of read and write operations, MDS offers extended services for file management. Please refer to the Motoman Device Server User’s manual (P/N 145925-1) for more information.

For more information on OPC standards, please refer to the OPC Foundation website at www.opcfoundation.org.

The following diagram depicts the software architecture:
1.2 System Requirements

Motoman OPC Server has been designed following the client/server structure for standard network protocols. In addition, it has been specifically designed for Microsoft's Windows family of operating systems. The hardware and operating software requirements are standard for its class of applications.

Client access

Computer running any of the following operating systems:
Windows® 9x, Windows ME, NT® 4.0, 2000, or XP can access OPC servers.

Additionally the following pre-requisites must be met:
- Client OPC Data Access components 2.0 must be installed
- The server PC should grant the appropriate access rights to the client PC
- Computers running Windows® 9x must have DCOM installed

Server

Computer running any of the following operating systems:
Windows® 2000/XP®

RS232 or Ethernet connection to robot controller

Minimum graphical resolution 800x600

128 MB RAM (may depend on # of robot connections)

Network card

MDS (Motoman Device Server) installed and communication licenses purchased

(Please contact Motoman at 1-937-847-3200 to order this application).

1.3 Installation

The Motoman OPC Server application's installation files are located on the Motoman CD Browser (P/N 141720-1). Please refer to the CD-Browser for detailed installation instructions.

The OPC Server application files are installed in c:\Program Files\Motoman\OPC Server\. To install OPC Server, proceed as follows:

1. Insert the CD-ROM Browser into the CD-ROM drive on the computer.
2. The setup program begins automatically.

Note: Setup executes automatically when the CD is inserted into the CD-ROM drive unless autoexecute has been disabled on your computer. If the setup program does not autoexecute, select demo32.exe from the CD-ROM Open Properties dialog. Demoshield Player appears and prompts you for a .dbd file. Double-click *.dbd to begin the install process.

3. The introduction screen appears. Click Next to continue.
4. Click the Communication Software button. The Motoman Software License Agreement page appears.

5. Click the Accept button to agree to the terms outlined in the scrolling window. The software selection screen appears.
6. Click the Motoman OPC Server button. The OPC Server Software package screen appears.

7. Install all four software components in numerical order (1 through 4).
8. Follow the install instructions for each component as you are guided through the installation process.

Once installation has been successfully completed, the files needed for the components are added, including the (MDS) Motoman Device Server. Now, having all the files necessary to run the Motoman OPC Server application, proceed to configure the DCOM for your operating system.
1.3.1 **DCOM Configuration (Windows 2000)**

1. From the Windows desktop, click Start > Run.
2. Type: “dcomcnfg” in the text field and click OK. The Distributed COM window appears.
3. Select the Default Properties tab.
4. Set the Default Authentication Level to None and click OK.
5. Select the Default Security tab.

6. Click the Edit Default button for the Default Access Permissions section. The Registry Value Permissions window for the Default Launch Permission registry appears.
7. Add INTERACTIVE, NETWORK, SYSTEM, and Everyone, and click OK.
8. Click the Edit Default button under the Default Launch Permissions section of the Default Security tab. The Registry Value Permissions window for the HKEY_CLASSES_ROOT registry appears.

9. Add INTERACTIVE, NETWORK, SYSTEM and Everyone, and click OK.
10. Click on the Applications tab.
11. Locate and select the MotOPCSvrR application by double-clicking on MotOPCSvrR or highlighting MotOPCSvrR and clicking the Properties button. The MotOPCSvrR Properties window appears.
12. Set the Authentication Level to None, and click OK.
13. Locate and select the OpcEnum application from the list. The OpcEnum Properties window appears.

14. Set the Authentication Level to None, and click OK.
1.3.2 DCOM Configuration (Windows XP)

1. From the Windows desktop, click Start > Run.
2. Type: “dcomcnfg” in the text field and click OK. The Component Services window appears.

3. Double-click Component Services from the Console Root sub-window. The Component Services sub-window appears.


6. Right click on My Computer from the Console Root tree and select Properties from the dropdown menu. The My Computer Properties window appears.
7. Select the Default Properties tab and set the Default Authentication Level to None and click OK.
8. Select the Default COM Security tab.

10. Add Everyone, INTERACTIVE, NETWORK, AND SYSTEM to the list and click OK.

11. Click OK in the My Computer Properties window.

12. Double-click the DCOM Config folder in the Component Services window. The component application list appears.

13. Right-click on the MotOPCSvrR application and select Properties from the drop-down menu. The MotOPCSvrR Properties window appears.
14. Set the Authentication Level to None and click OK.
15. Right-click on the OPCEnum application and select Properties from the drop-down menu. The OpcEnum Properties window appears.

16. Set the Authentication Level to None and click OK.
17. Close all open windows and restart your computer to allow new settings to take effect.
1.4 Reference to Other Documentation

For additional information refer to the following:

- Motoman Device Server User’s manual (P/N 145925-1)
- Application-specific Motoman manuals
- Vendor manuals for system components not manufactured by Motoman

1.5 Customer Service Information

If you are in need of technical assistance, contact the Motoman service staff at (937) 847-3200. Please have the following information ready before you call:

- Operating system (Windows 95®, Windows NT®)
- System configuration (hard disk capacity, memory, software, etc.)
- Description of difficulty (make a note of any error messages)
SECTION 2
SAFETY

2.1 Introduction

It is the purchaser's responsibility to ensure that all local, county, state, and national codes, regulations, rules, or laws relating to safety and safe operating conditions for each installation are met and followed.

We suggest that you obtain and review a copy of the ANSI/RIA National Safety Standard for Industrial Robots and Robot Systems. This information can be obtained from the Robotic Industries Association by requesting ANSI/RIA R15.06. The address is as follows:

Robotic Industries Association
900 Victors Way
P.O. Box 3724
Ann Arbor, Michigan 48106
TEL: 313/994-6088
FAX: 313/994-3338

Ultimately, the best safeguard is trained personnel. The user is responsible for providing personnel who are adequately trained to operate, program, and maintain the robot cell. The robot must not be operated by personnel who have not been trained!

We recommend that all personnel who intend to operate, program, repair, or use the robot system be trained in an approved Motoman training course and become familiar with the proper operation of the system.

This safety section addresses the following:
• Standard Conventions (Section 2.2)
• General Safeguarding Tips (Section 2.3)
• Mechanical Safety Devices (Section 2.4)
• Installation Safety (Section 2.5)
• Programming Safety (Section 2.6)
• Operation Safety (Section 2.7)
• Maintenance Safety (Section 2.8)
2.2 Standard Conventions

This manual includes information essential to the safety of personnel and equipment. As you read through this manual, be alert to the four signal words:

- DANGER
- WARNING
- CAUTION
- NOTE

Pay particular attention to the information provided under these headings which are defined below (in descending order of severity).

**DANGER!**

Information appearing under the DANGER caption concerns the protection of personnel from the immediate and imminent hazards that, if not avoided, will result in immediate, serious personal injury or loss of life in addition to equipment damage.

**WARNING!**

Information appearing under the WARNING caption concerns the protection of personnel and equipment from potential hazards that can result in personal injury or loss of life in addition to equipment damage.

**CAUTION!**

Information appearing under the CAUTION caption concerns the protection of personnel and equipment, software, and data from hazards that can result in minor personal injury or equipment damage.

NOTE: Information appearing in a NOTE caption provides additional information which is helpful in understanding the item being explained.
### 2.3 General Safeguarding Tips

All operators, programmers, plant and tooling engineers, maintenance personnel, supervisors, and anyone working near the robot must become familiar with the operation of this equipment. All personnel involved with the operation of the equipment must understand potential dangers of operation. General safeguarding tips are as follows:

- Improper operation can result in personal injury and/or damage to the equipment. Only trained personnel familiar with the operation of this robot, the operator's manuals, the system equipment, and options and accessories should be permitted to operate this robot system.
- Do not enter the robot cell while it is in automatic operation. Programmers must have the teach pendant when they enter the robot cell.
- Improper connections can damage the robot. All connections must be made within the standard voltage and current ratings of the robot I/O (Inputs and Outputs).
- The robot must be placed in Emergency Stop (E-STOP) mode whenever it is not in use.
- In accordance with ANSI/RIA R15.06, section 6.13.4 and 6.13.5, use lockout/tagout procedures during equipment maintenance. Refer also to Section 1910.147 (29CFR, Part 1910), Occupational Safety and Health Standards for General Industry (OSHA).

### 2.4 Mechanical Safety Devices

The safe operation of the robot, positioner, auxiliary equipment, and system is ultimately the user's responsibility. The conditions under which the equipment will be operated safely should be reviewed by the user. The user must be aware of the various national codes, ANSI/RIA R15.06 safety standards, and other local codes that may pertain to the installation and use of industrial equipment. Additional safety measures for personnel and equipment may be required depending on system installation, operation, and/or location. The following safety measures are available:

- Safety fences and barriers
- Light curtains
- Door interlocks
- Safety mats
- Floor markings
- Warning lights

Check all safety equipment frequently for proper operation. Repair or replace any non-functioning safety equipment immediately.
2.5 **Installation Safety**

Safe installation is essential for protection of people and equipment. The following suggestions are intended to supplement, but not replace, existing federal, local, and state laws and regulations. Additional safety measures for personnel and equipment may be required depending on system installation, operation, and/or location. Installation tips are as follows:

- Be sure that only qualified personnel familiar with national codes, local codes, and ANSI/RIA R15.06 safety standards are permitted to install the equipment.
- Identify the work envelope of each robot with floor markings, signs, and barriers.
- Position all controllers outside the robot work envelope.
- Whenever possible, install safety fences to protect against unauthorized entry into the work envelope.
- Eliminate areas where personnel might get trapped between a moving robot and other equipment (pinch points).
- Provide sufficient room inside the workcell to permit safe teaching and maintenance procedures.

2.6 **Programming Safety**

All operators, programmers, plant and tooling engineers, maintenance personnel, supervisors, and anyone working near the robot must become familiar with the operation of this equipment. All personnel involved with the operation of the equipment must understand potential dangers of operation. Programming tips are as follows:

- Any modifications to PART 1 of the MRC controller PLC can cause severe personal injury or death, as well as damage to the robot! Do not make any modifications to PART 1. Making any changes without the written permission of Motoman will VOID YOUR WARRANTY!
- Some operations require standard passwords and some require special passwords. Special passwords are for Motoman use only. YOUR WARRANTY WILL BE VOID if you use these special passwords.
- Back up all programs and jobs onto a floppy disk whenever program changes are made. To avoid loss of information, programs, or jobs, a backup must always be made before any service procedures are done and before any changes are made to options, accessories, or equipment.
- The concurrent I/O (Input and Output) function allows the customer to modify the internal ladder inputs and outputs for maximum robot performance. Great care must be taken when making these modifications. Double-check all modifications under every mode of robot operation to ensure that you have not created hazards or dangerous situations that may damage the robot or other parts of the system.
- Improper operation can result in personal injury and/or damage to the equipment. Only trained personnel familiar with the operation, manuals, electrical design, and equipment interconnections of this robot should be permitted to operate the system.
• Inspect the robot and work envelope to be sure no potentially hazardous conditions exist. Be sure the area is clean and free of water, oil, debris, etc.
• Be sure that all safeguards are in place.
• Check the E-STOP button on the teach pendant for proper operation before programming.
• Carry the teach pendant with you when you enter the workcell.
• Be sure that only the person holding the teach pendant enters the workcell.
• Test any new or modified program at low speed for at least one full cycle.

2.7 Operation Safety

All operators, programmers, plant and tooling engineers, maintenance personnel, supervisors, and anyone working near the robot must become familiar with the operation of this equipment. All personnel involved with the operation of the equipment must understand potential dangers of operation. Operation tips are as follows:

• Be sure that only trained personnel familiar with the operation of this robot, the operator's manuals, the system equipment, and options and accessories are permitted to operate this robot system.
• Check all safety equipment for proper operation. Repair or replace any non-functioning safety equipment immediately.
• Inspect the robot and work envelope to ensure no potentially hazardous conditions exist. Be sure the area is clean and free of water, oil, debris, etc.
• Ensure that all safeguards are in place.
• Improper operation can result in personal injury and/or damage to the equipment. Only trained personnel familiar with the operation, manuals, electrical design, and equipment interconnections of this robot should be permitted to operate the system.
• Do not enter the robot cell while it is in automatic operation. Programmers must have the teach pendant when they enter the cell.
• The robot must be placed in Emergency Stop (E-STOP) mode whenever it is not in use.
• This equipment has multiple sources of electrical supply. Electrical interconnections are made between the controller, external servo box, and other equipment. Disconnect and lockout/tagout all electrical circuits before making any modifications or connections.
• All modifications made to the controller will change the way the robot operates and can cause severe personal injury or death, as well as damage the robot. This includes controller parameters, ladder parts 1 and 2, and I/O (Input and Output) modifications. Check and test all changes at slow speed.
2.8 Maintenance Safety

All operators, programmers, plant and tooling engineers, maintenance personnel, supervisors, and anyone working near the robot must become familiar with the operation of this equipment. All personnel involved with the operation of the equipment must understand potential dangers of operation. Maintenance tips are as follows:

- Do not perform any maintenance procedures before reading and understanding the proper procedures in the appropriate manual.
- Check all safety equipment for proper operation. Repair or replace any non-functioning safety equipment immediately.
- Improper operation can result in personal injury and/or damage to the equipment. Only trained personnel familiar with the operation, manuals, electrical design, and equipment interconnections of this robot should be permitted to operate the system.
- Back up all your programs and jobs onto a floppy disk whenever program changes are made. A backup must always be made before any servicing or changes are made to options, accessories, or equipment to avoid loss of information, programs, or jobs.
- Do not enter the robot cell while it is in automatic operation. Programmers must have the teach pendant when they enter the cell.
- The robot must be placed in Emergency Stop (E-STOP) mode whenever it is not in use.
- Be sure all safeguards are in place.
- Use proper replacement parts.
- This equipment has multiple sources of electrical supply. Electrical interconnections are made between the controller, external servo box, and other equipment. Disconnect and lockout/tagout all electrical circuits before making any modifications or connections.
- All modifications made to the controller will change the way the robot operates and can cause severe personal injury or death, as well as damage the robot. This includes controller parameters, ladder parts 1 and 2, and I/O (Input and Output) modifications. Check and test all changes at slow speed.
- Improper connections can damage the robot. All connections must be made within the standard voltage and current ratings of the robot I/O (Inputs and Outputs).
SECTION 3

USING THE OPC CONTROL CONSOLE

3.1 Overview

The OPC Control Console provides the GUI (Graphical User Interface) through which the OPC server application can be configured. The user is able to add, remove, and edit device connections, provided by a variety of device extensions.

The following sections describe the usage of the OPC Control Console application. You will be supplied with all the necessary information required to use this application with no difficulty. You will be provided with details on topics such as:

- Description of the OPC Control Console main application window
- Complete functionality to using the OPC Control Console application

3.2 Starting the Motoman Control Console Application

To start the OPC Control Console application:

1. Click the Start button on the Windows desktop.
2. Select Programs > Motoman > OPC Control Console.

OR

3. Double-click the OPC Control Console icon located on the Windows desktop

3.3 Description of OPC Control Console

The main application window contains a list of device connections currently configured by the Motoman OPC Server application. Each connection is represented by a single row as shown below.

The following information is presented for each configured connection:

- Connection
- Type
- Status
The toolbar consists of shortcuts relating to the functionality of the application. The shortcuts available include the following:

- exits the application
- adds a connection
- removes a connection
- edits a connection
- opens a connection
- closes a connection
- shows status of a connection
3.4 **Connections**

All of the administration of the connections for the OPC Console application are contained within the main application window. From this window, you can add, remove, edit, open, close, or check the status of a connection.

3.4.1 **Add Connection**

To add a new connection, begin by selecting Add Connection from the Connections menu. The Add Connection Wizard begins. Enter the Connection Name and Connection Type. A description of the Connection Type is displayed in the text area. Press Next to continue. Press Cancel to exit the operation.

*Note: The requested information must be entered to enable the Next button*

![Add Connection Wizard](image)

Please enter the connection name. A connection represents an abstraction of a physical device. In terms of OPC it is equivalent to an OPC group. Each connection groups device specific items.

- **Connection Name**: Connection 1
- **Connection Type**: Motoman ERC, MRC, XRC DII

Motoman ERC, MRC, XRC DII Extension
The DII Extension uses Motman device server to connect to Motoman robots.

Continue by entering the values for the requested attributes, in this particular case these are Server and Device. Click Back to return to the previous window. Press Next to continue. Press Cancel to exit the operation.
Note: The Server Value is not required if the OPC Server is located on the local machine.

The final dialog box presents a summary or overview of the connection. Click Finish to complete the new connection process.

Note: OPC Server attempts to open the connection. If this is unsuccessful, the new connection will not be added.
3.4.2 Remove a Connection

To remove a connection, simply select the connection, and select Remove from the Connection menu.

A dialog box appears confirming that you wish to remove the connection. Click Yes to continue. Click No to exit the operation.

3.4.3 Edit a Connection

To edit a connection, begin by selecting the connection from the listing, and select Edit from the Connection menu.

Modify the information and press the Apply button to apply the changes. Press OK to save the changes and exit the Configure Connection dialog box. Press the Cancel button to exit the operation.

3.4.4 Open a Connection

To open an existing connection, select the connection from the list and select Open from the Connections menu.

3.4.5 Close a Connection

To close an existing connection, select the connection from the list and select Close from the Connection menu.
A dialog box opens confirming that you wish to close the selected connection. Click Yes to continue. Click No to exit the operation.

3.4.6 **Status Details**

By selecting Status from the Connection menu or pressing the Status button, you can view the status of a connection.

[Image: OPC Control Console dialog box]

A dialog box opens with the connection status information. Press OK to close the dialog box.

3.5 **Help**

The Help menu supplies the user with information about the Motoman OPC server and access to a help file for the application.

3.5.1 **About**

Select the About item from the Help menu to view specific information regarding the OPC control console.
3.6 Exiting the Application

To exit the application, simply select Exit from the File menu.
SECTION 4
USING THE OPC SERVER

4.1 Overview

Motoman OPC Server was developed using the OLE for Process Control (or OPC) specification (which includes OPC 2.0). This specification, developed by the OPC Foundation, is based upon Microsoft's Object Linking and Embedding (OLE) / Component Object Model (COM) technology. The Motoman OPC standard interface makes possible interoperability between automation/control applications, field systems/devices, and business/office applications.

OPC is an industry standard created by a number of leading worldwide automation and hardware/software suppliers and Microsoft. OPC ensures that automation systems share information and interoperate with other automation and business systems plant or factory wide. The number of members participating in the OPC Foundation is constantly increasing.

The Motoman OPC Server application allows COM-based applications to communicate over the network using OPC and a custom COM/DCOM interface with XRC, MRC and ERC robot controllers. While the client applications perform the communication using simple, easy to use automation enabled objects, the server in turn communicates with the robot controllers.

One instance of the server can provide simultaneous connectivity to multiple robots or, in other words, it can serve multiple connections. A connection represents a link between the server and the robot controller. A connection can be shared between multiple client applications.

For more information on OPC standards, please refer to the OPC Foundation website at www.opcfoundation.org.
# Item References

Listed below are the items supported by the Motoman OPC Server. Each item is explained in more detail in the next few sections.

**Note:** *AliasName represents the name of the configured connection from the OPC Control Console application.*

<table>
<thead>
<tr>
<th>Access Path</th>
<th>Access Rights</th>
<th>Item Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group: Status Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Playback.Cycle</td>
<td>R/W</td>
<td>VT_14</td>
</tr>
<tr>
<td>Playback.Mode</td>
<td>R/W</td>
<td>VT_14</td>
</tr>
<tr>
<td>Playback.ServoPower</td>
<td>R/W</td>
<td>VT_14</td>
</tr>
<tr>
<td>Status.CommandRemote</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Status.SafetySpeed</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td><strong>Group: Job Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job.HoldStatus</td>
<td>R/W</td>
<td>VT_14</td>
</tr>
<tr>
<td>Job.StartStatus</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Job.Name</td>
<td>R</td>
<td>BSTR</td>
</tr>
<tr>
<td>Job.Line</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Job.Step</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td><strong>Group: Alarms and Errors</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm.AlarmStatus</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Alarm.ErrorStatus</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Alarm.ErrorCode</td>
<td>R</td>
<td>VT_14</td>
</tr>
<tr>
<td>Alarm.AlarmCode</td>
<td>R</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td><strong>Group: Concurrent IO</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIO.0010-CIO.9040</td>
<td>R/W</td>
<td>VT_UI1</td>
</tr>
<tr>
<td><strong>Group: Variables</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable.B1-256</td>
<td>R/W*</td>
<td>VT_UI1</td>
</tr>
<tr>
<td>Variable.I1-256</td>
<td>R/W*</td>
<td>VT_I2</td>
</tr>
<tr>
<td>Variable.D1-256</td>
<td>R/W*</td>
<td>VT_UI4</td>
</tr>
<tr>
<td>Variable.R1-256</td>
<td>R/W*</td>
<td>VT_R4</td>
</tr>
<tr>
<td>Variable.P1-256</td>
<td>R/W*</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td>Variable.BP1-256</td>
<td>R/W*</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td>Variable.SP1-256</td>
<td>R/W*</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td><strong>Group: Positions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position.Cartesian.coordinate_system, ext_axis</td>
<td>R</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td>Position.Pulse</td>
<td>R</td>
<td>VT_ARRAYIVT_14</td>
</tr>
<tr>
<td><strong>Group: Frames</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame.UserCoordinateNo</td>
<td>R</td>
<td>VT_ARRAYIVT_14</td>
</tr>
</tbody>
</table>

* Write access only available on XRC.
4.2.1 Status Information

**Playback.Cycle**
This item is used to read and write the values of a robot controller’s cycle status.

- **Item Syntax**: `AliasName.Playback.Cycle`
- **Access Rights**: R,W
- **Possible Values**:
  1: Step
  2: 1-cycle
  3: Auto

**Playback.Mode**
This item is used to read and write the values of a robot controller’s Playback Mode (either Teach or Play).

- **Item Syntax**: `AliasName.Playback.Mode`
- **Access Rights**: R,W
- **Possible Values**:
  1: Teach
  2: Play

**Playback.ServoPower**
This item is used to read and write the values of a robot controller’s servo power.

- **Item Syntax**: `AliasName.Playback.ServoPower`
- **Access Rights**: R,W
- **Possible Values**:
  0: Off
  2: On

**Status.CommandRemote**
This item is used to read the value of a robot controller’s Command Remote status.

- **Item Syntax**: `AliasName.Status.CommandRemote`
- **Access Rights**: R
- **Possible Values**: 0,1

**Status.SafetySpeed**
This item is used to read the value of a robot controller’s Safety Speed status.

- **Item Syntax**: `AliasName.Status.SafetySpeed`
- **Access Rights**: R
- **Possible Values**: 0,1
4.2.2 Job Information

**Job.HoldStatus**
This item is used to read and write the values of a robot controller’s hold status.

- **Item Syntax** \( AliasName \).Job.HoldStatus
- **Access Rights** R, W
- **Possible Values**
  - 0 : Off
  - 1 : On

**Job.StartStatus**
This item is used to read the value of a robot controller’s status of operation.

- **Item Syntax** \( AliasName \).Job.StartStatus
- **Access Rights** R
- **Possible Values**
  - 0 : Off
  - 1 : On

**Job.Name**
This item is used to read the current job name.

- **Item Syntax** \( AliasName \).Job.Name
- **Access Rights** R

**Job.Line**
This item is used to read the current line number.

- **Item Syntax** \( AliasName \).Job.Line
- **Access Rights** R

**Job.Step**
This item is used to read the current step number.

- **Item Syntax** \( AliasName \).Job.Step
- **Access Rights** R
4.2.3 Alarms and Errors

**Alarm.AlarmStatus**
This item is used to read the value of a robot controller’s alarm status.

- Item Syntax: `AliasName.Alarm.AlarmStatus`
- Access Rights: R

**Alarm.ErrorStatus**
This item is used to read the value of a robot controller’s error status.

- Item Syntax: `AliasName.Alarm.ErrorStatus`
- Access Rights: R

**Alarm.ErrorCode**
This item is used to read the value of a robot controller’s error code.

- Access Rights: R

**Alarm.AlarmCode**
This item is used to read the value of a robot controller’s alarm code.

- Access Rights: R

4.2.4 Concurrent IO

**CIO.0010-CIO.9040**
This item is used to read the value of a robot controller’s error code.

- Item Syntax: `AliasName.CIO.N`
- Access Rights: R,W
- Example: Connection 1.CIO.0010

**Note:** Refer to the controller manual for more information on Concurrent IO. Only selected ranges of outputs can be written using Host Communication interface.
4.2.5 Variables

**Variable.B1-256**
This item is used to read and write byte variables of a robot controller.

- **Item Syntax**: `AliasName.Variable.BN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.B1

**Variable.I1-256**
This item is used to read and write integer variables of a robot controller.

- **Item Syntax**: `AliasName.Variable.IN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.I1

**Variable.D1-256**
This item is used to read and write double (long integer) variables of a robot controller.

- **Item Syntax**: `AliasName.Variable.DN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.R1

**Variable.P1-256**
This item is used to read and write robot position type variable data of a robot controller.

- **Item Syntax**: `AliasName.Variable.PN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.P1

**Variable.BP1-256**
This item is used to read and write base position variable data of a robot controller.

- **Item Syntax**: `AliasName.Variable.BPN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.BP1

**Variable.SP1-256**
This item is used to read and write static position variable data of a robot controller.

- **Item Syntax**: `AliasName.Variable.SPN`
- **Access Rights**: R,W*
- **Example**: Connection 1.Variable.SP1

* Write access only available on XRC.
4.2.6 Positions

**Position.Car<sub>s</sub>esian.coordinate_system.ext_axis**
This item is used to read the value of a robot controller’s specified coordinate system.

<table>
<thead>
<tr>
<th>Item Syntax</th>
<th>Access Rights</th>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AliasName.Position.Car&lt;sub&gt;s&lt;/sub&gt;esian.coordinate_system.ext_axis</td>
<td>R</td>
<td>Connection 1.Position.Car&lt;sub&gt;s&lt;/sub&gt;esian.1.E - with external axis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connection 1.Position.Car&lt;sub&gt;s&lt;/sub&gt;esian.1.E - without external axis</td>
</tr>
</tbody>
</table>

**Position.Pulse**
This item is used to read the value of a robot controller’s joint coordinate system.

<table>
<thead>
<tr>
<th>Item Syntax</th>
<th>Access Rights</th>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Connection 1.Position.Car&lt;sub&gt;s&lt;/sub&gt;esian.1.E - without external axis</td>
</tr>
</tbody>
</table>

4.2.7 Frames

**Frame.UserCoordinateNo**
This item is used to read the value of a robot controller’s specified coordinate system.

<table>
<thead>
<tr>
<th>Item Syntax</th>
<th>Access Rights</th>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Connection 1.Position.Car&lt;sub&gt;s&lt;/sub&gt;esian.1.E - without external axis</td>
</tr>
</tbody>
</table>

* Write access only available on XRC.
NOTES
# INDEX

## A
- Alarm.AlarmCode, 4-5
- Alarm.AlarmStatus, 4-5
- Alarm.ErrorCode, 4-5
- Alarm.ErrorStatus, 4-5
- Alarms and Errors, 4-5
  - ANSI/RIA, 2-1

## C
- CIO.0010-CIO.9040, 4-5
- Client access, 1-2
- Concurrent IO, 4-5
- Customer Service Information, 1-14

## D
- DCOM Configuration, 1-5
  - Windows 2000, 1-5
  - Windows XP, 1-9
- Description of OPC Control Console, 3-1

## E
- Exiting the Application, 3-7

## F
- Frames, 4-7
  - User Coordinate No, 4-7

## G
- General Safeguarding Tips, 2-3

## H
- Help, 3-6

## I
- Installation, 1-2
- Installation Safety, 2-4
- Introduction, 1-1
- Item References, 4-2

## J
- Job Information, 4-4
- Job.HoldStatus, 4-4
- Job.Line, 4-4
- Job.Name, 4-4
- Job.StartStatus, 4-4
- Job.Step, 4-4

## M
- Maintenance Safety, 2-6
- Mechanical Safety Devices, 2-3

## O
- OPC Control Console, 3-1
  - Add Connection, 3-3
  - Close a Connection, 3-5
  - Connections, 3-3
  - Edit a Connection, 3-5
  - Open a Connection, 3-5
  - Remove a Connection, 3-5
- OPC Server, 4-1
- Operation Safety, 2-5
- Overview, 1-1

## P
- Playback.Cycle, 4-3
- Playback.Mode, 4-3
- Playback.ServoPower, 4-3
- Position
  - Cartesian coordinate system, 4-7
  - Pulse, 4-7
  - Positions, 4-7
  - Programming Safety, 2-4

## R
- Reference to Other Documentation, 1-14
  - Robotic Industries Association, 2-1

## S
- Safety, 2-1
- Server, 1-2
- Standard Conventions, 2-2
- Starting the Motoman Control Console
  - Application, 3-1
  - Status Details, 3-6
  - Status Information, 4-3
- Status.CommandRemote, 4-3
- Status.SafetySpeed, 4-3
- System Requirements, 1-2
INDEX

\( V \)
Variables, 4-6
\( B1-256, 4-6 \)
\( BP1-256, 4-6 \)
\( D1-256, 4-6 \)
\( I1-256, 4-6 \)
\( P1-256, 4-6 \)
\( SP1-256, 4-6 \)